
Q .1Q .1 Whic h of the fo l lowing A rt ic les  provides  for  the C ons t itut ion of the Par l iament?Whic h of the fo l lowing A rt ic les  provides  for  the C ons t itut ion of the Par l iament?

A nsA ns 1. Article 82
2. Article 86
3. Article 79
4. Article 84

Q .2Q .2 In whic h of the fo l lowing y ears  d id  S wami V ivekananda attend the World ’sIn whic h of the fo l lowing y ears  d id  S wami V ivekananda attend the World ’s
Par l iament of Rel igions?Par l iament of Rel igions?

A nsA ns 1. 1783 AD
2. 1793 AD
3. 1893 AD
4. 1890 AD

Q .3Q .3 Whic h A rt ic le of  the Indian C ons t itut ion provides  the S upreme C ourt  the powerWhic h A rt ic le of  the Indian C ons t itut ion provides  the S upreme C ourt  the power
to rev iew its  own judgements  and orders?to  rev iew its  own judgements  and orders?

A nsA ns 1. Article 135
2. Article 137
3. Article 136
4. Article 138

Q .4Q .4 Who founded the S oc ia l  S erv ice L eague in Bombay  in 1 91 1  to  s ec ure betterWho founded the S oc ia l  S erv ice L eague in Bombay  in 1 91 1  to  s ec ure better
c ondit ions  of l i fe and work  for  the mas s es?c ondit ions  of l i fe and work  for  the mas s es?

A nsA ns 1. Gopal Krishna Gokhale
2. Narayan Malhar Joshi
3. Mahatma Gandhi
4. Raja Ram Mohan Roy
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Q . 5Q . 5 A cc ording to  the M inis try  of  M ines ,  G overnment of Ind ia ,  whic h s tate is  theA cc ording to  the M inis try  of  M ines ,  G overnment of Ind ia ,  whic h s tate is  the
larges t  producer  of iron ore in Ind ia  (as  of  A pr i l - January  2 0 2 1 -2 2 ) ?larges t  producer  of iron ore in Ind ia  (as  of  A pr i l - January  2 0 2 1 -2 2 ) ?

A nsA ns 1. Jharkhand
2. West Bengal
3. Chhattisgarh
4. Odisha

Q .6Q .6 O n 1O n 1   November 2 0 24 ,  the G overnment has  approved the C entral  S ec tor  S c hemeNovember 2 0 24 ,  the G overnment has  approved the C entral  S ec tor  S c heme
‘Namo Drone Did i ’ for  provid ing drones  to  the Women S elf  Help G roups  ( S HG s)‘Namo Drone Did i ’ for  provid ing drones  to  the Women S elf  Help G roups  ( S HG s)
under  DAY- NRL M , with an outlay  of _______________ .under  DAY- NRL M , with an outlay  of _______________ .

A nsA ns 1. ₹126 crores
2. ₹1,261 crores
3. ₹121 crores
4. ₹161 crores

Q .7Q .7 Where wi l l  the 3 8Where wi l l  the 3 8t ht h  Nat ional  G ames  be held? National  G ames  be held?

A nsA ns 1. 
2. 
3. 
4. 

Q .8Q .8 Whic h s pace agenc y  launc hed S hukray an- 1  in December 2 0 24  to  explore Venus?Whic h s pace agenc y  launc hed S hukray an- 1  in December 2 0 24  to  explore Venus?
A nsA ns 1. DRDO

2. The Defence Space Agency
3. ISRO
4. National Remote Sensing Centre

Q .9Q .9 Before bec oming the 1 2Before bec oming the 1 2t ht h  Pres ident of Ind ia ,  Prat ibha Devis ingh Pat i l  was  the Pres ident of Ind ia ,  Prat ibha Devis ingh Pat i l  was  the
G overnor  of whic h of the fo l lowing s tates?G overnor  of whic h of the fo l lowing s tates?

A nsA ns 1. Nagaland
2. Rajasthan
3. Madhya Pradesh
4. Himachal Pradesh
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Q .1 0Q .1 0 Whic h of the fo l lowing r ivers  r is es  near  L ake M ans arowar?Whic h of the fo l lowing r ivers  r is es  near  L ake M ans arowar?
A nsA ns 1. Narmada

2. Ganga
3. Godavari
4. Indus

Q .1 1Q .1 1 Dur ing the M ughal  per iod ,  ‘M ans ab’ referred to  whic h of the fo l lowing?During the M ughal  per iod ,  ‘M ans ab’ referred to  whic h of the fo l lowing?
A nsA ns 1. One who holds a position

2. One who holds a state

3. One who holds sword
4. One who holds a military contingent

Q .1 2Q .1 2 The M a Kamakhy a Temple is  loc ated in _________ .The M a Kamakhy a Temple is  loc ated in _________ .
A nsA ns 1. Indore

2. Guwahati
3. Udaipur
4. Kanpur

Q .1 3Q .1 3 Whic h of the fo l lowing is  the larges t  tr ibutary  ( by  vo lume/dis c harge)  of  the IndusWhic h of the fo l lowing is  the larges t  tr ibutary  ( by  vo lume/dis c harge)  of  the Indus
River?River?

A nsA ns 1. Chenab
2. Jhelum
3. Sutlej
4. Ravi

Q .1 4Q .1 4 Whic h organis at ion organis ed the nat ional  c onference on educ at ion,  inc lus ionWhic h organis at ion organis ed the nat ional  c onference on educ at ion,  inc lus ion
and empowerment of minor ity  c ommunit ies ,  held  in New Delhi ,  on 2 5 M arc hand empowerment of minor ity  c ommunit ies ,  held  in New Delhi ,  on 2 5 M arc h
2 0 2 5?2 0 2 5?

A nsA ns 1. Ministry of Minority Affairs
2. National Commission for Scheduled Castes (NCSC)
3. National Human Rights Commission (NHRC)
4. National Commission for Minorities (NCM)
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Q .1 5Q .1 5 Ramgarh V is hdhar i  Wild l i fe S anc tuary ,  Ramgarh V is hdhar i  Wild l i fe S anc tuary ,  des ignated as  a  t iger  res erve,  is  loc ated indes ignated as  a  t iger  res erve,  is  loc ated in
whic h of the fo l lowing Indian s tates?whic h of the fo l lowing Indian s tates?

A nsA ns 1. Gujarat
2. Maharashtra
3. Madhya Pradesh
4. Rajasthan

Q .1 6Q .1 6 With whic h of the fo l lowing is  G okuldas  Tejpal  S ans kr it  Paths hala as s oc iated?With whic h of the fo l lowing is  G okuldas  Tejpal  S ans kr it  Paths hala as s oc iated?
A nsA ns 1. The place where Subash Chandra Bose formed the Forward Bloc

2. The place where the Congress and the Muslim League split
3. The place where the first session of the Indian National Congress was held
4. The place where the salt law was broken by Gandhiji

Q .1 7Q .1 7 Whic h Indian leader  s erved twice as  Inter im Pr ime M inis ter  and was  known for  hisWhic h Indian leader  s erved twice as  Inter im Pr ime M inis ter  and was  known for  his
expert is e in labour  is s ues?expert is e in labour  is s ues?

A nsA ns 1. Morarji Desai
2. Jagjivan Ram
3. VV Giri
4. Gulzarilal Nanda

Q .1 8Q .1 8 Whic h among the fo l lowing S ultans  of Delhi  trans ferred his  c apital  from Delhi  toWhic h among the fo l lowing S ultans  of Delhi  trans ferred his  c apital  from Delhi  to
Deogir  ( Daultabad) ?Deogir  ( Daultabad) ?

A nsA ns 1. Shamsuddin Iltutmish
2. Ghiyasuddin Balban
3. Qutbuddin Aibak
4. Muhammad Bin Tughlaq

Q .1 9Q .1 9 O n 24  O c tober  2 0 24 ,  how o ld  d id  United Nations  bec ome?O n 24  O c tober  2 0 24 ,  how o ld  d id  United Nations  bec ome?
A nsA ns 1. 82 years

2. 70 years

3. 79 years
4. 73 years
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Q .2 0Q .2 0 During the 2 0 24  BRIC S  S ummit ,  whic h regional  c onfl ic t  d id  Rus s ian Pres identDuring the 2 0 24  BRIC S  S ummit ,  whic h regional  c onfl ic t  d id  Rus s ian Pres ident
Putin warn was  c los e to  es c alat ing into  a  ful l - s c ale war?Putin warn was  c los e to  es c alat ing into  a  ful l - s c ale war?

A nsA ns 1. Tensions in the South China Sea
2. The India-Pakistan border issue
3. The situation between Israel and Iran
4. The Taiwan Strait conflict

Q .2 1Q .2 1 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?  DO E S  NO T belong to  that  group?  
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter- c lus ter. )pos it ion in the letter- c lus ter. )

A nsA ns 1. JEG
2. PKN
3. SNQ
4. MHK

Q .2 2Q .2 2 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter  c lus ter. )pos it ion in the letter  c lus ter. )

A nsA ns 1. PRO
2. MNJ
3. VXU
4. IKH

Section : Logical Reasoning
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Q .2 3Q .2 3 A  paper  is  fo lded and c ut  as  s hown below.  How wi l l  i t  appear  when unfolded?A  paper  is  fo lded and c ut  as  s hown below.  How wi l l  i t  appear  when unfolded?

A nsA ns 1. 

2. 

3. 

4. 
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Q .24Q .24 Whic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the patternWhic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the pattern
and relat ions hip fo l lowed between the letter- c lus ter  pair  on the left  s ide of : :  isand relat ions hip fo l lowed between the letter- c lus ter  pair  on the left  s ide of : :  is
the s ame as  that  on the r ight  s ide of : : ?the s ame as  that  on the r ight  s ide of : : ?

# :  E DZ : :  BAW :  %# :  E DZ : :  BAW :  %
A nsA ns 1. # = KJF, % = VUQ

2. # = KLH, % = VUQ
           

3. # = KJE, % = UTP
4. # = KJF, % = VTR

Q .2 5Q .2 5 E ac h letter  in the word 'F ING E R'  is  c hanged to  the letter  immediately  preceding itE ac h letter  in the word 'F ING E R'  is  c hanged to  the letter  immediately  preceding it
in the E ngl is h a lphabetic al  order  and then al l  the letters  thus  formed arein the E ngl is h a lphabetic al  order  and then al l  the letters  thus  formed are
arranged in a lphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be fourth fromarranged in a lphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be fourth from
the r ight  in the new group of letters  thus  formed?the r ight  in the new group of letters  thus  formed?

A nsA ns 1. F
2. H
3. E
4. M

Q .2 6Q .2 6 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairsS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs
given below.  Both pairs  fo l low the s ame pattern.given below.  Both pairs  fo l low the s ame pattern.
E BZ−C ZXE BZ−C ZX
L IG −JG EL IG −JG E

A nsA ns 1. PLI−MJH
2. PMK−MKH 
3. PLI−NKI
4. PMK−NKI 

Q .2 7Q .2 7 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’
and ‘÷ ’ are interc hanged and ‘× ’ and ‘−’ are interc hanged?and ‘÷ ’ are interc hanged and ‘× ’ and ‘−’ are interc hanged?
1 8 + 2  − 3 7  ÷  1 8  + 2  ×  1 0  − 4  ÷  1 8  = ?1 8  + 2  − 3 7  ÷  1 8  + 2  ×  1 0  − 4  ÷  1 8  = ?

A nsA ns 1. 364
2. 320
3. 409
4. 331
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Q .2 8Q .2 8 H,  I ,  J ,  K ,  S,  T  and U are s itt ing around a c irc ular  table fac ing the centre of theH,  I ,  J ,  K ,  S,  T  and U are s itt ing around a c irc ular  table fac ing the centre of the
table.  O nly  U s its  between S  and J  when c ounted from left  of  J .  J  s its  third  to  thetable.  O nly  U s its  between S  and J  when c ounted from left  of  J .  J  s its  third  to  the
left  of  H .  T  s its  to  the immediate left  of  H .  I  is  not  an immediate neighbour  of J .left  of  H .  T  s its  to  the immediate left  of  H .  I  is  not  an immediate neighbour  of J .
Who s its  third  to  the left  of  K?Who s its  third  to  the left  of  K?

A nsA ns 1. S
2. H
3. T
4. J

Q .2 9Q .2 9 E ac h vowel  in the word HA IRDRE S S E R is  c hanged to  the third  letter  fo l lowing it  inE ac h vowel  in the word HA IRDRE S S E R is  c hanged to  the third  letter  fo l lowing it  in
the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to  the s ec ondthe E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to  the s ec ond
letter  preceding it  in the E ngl is h a lphabetic al  order.  How many  letters  wi l l  appearletter  preceding it  in the E ngl is h a lphabetic al  order.  How many  letters  wi l l  appear
exac t ly  twice in the letter- c lus ter  thus  formed?exac t ly  twice in the letter- c lus ter  thus  formed?

A nsA ns 1. Four
2. Two
3. Three
4. One

Q .3 0Q .3 0 What wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i fWhat wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f
‘+ ’ and ‘−’ are interc hanged,  and ‘× ’ and ‘÷ ’ are interc hanged?‘+’ and ‘−’ are interc hanged,  and ‘× ’ and ‘÷ ’ are interc hanged?

4  ÷  8  + 3 5 ×  7  – 6  = ?4  ÷  8  + 3 5 ×  7  – 6  = ?
A nsA ns 1. 27

2. 33
3. 67
4. 47

Q .3 1Q .3 1 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 1 4  1 1 4  1 1 8  1 1 8  1 2 6 1 2 6 1 3 0  1 3 0  1 3 8 1 3 8 ??
A nsA ns 1. 144

2. 142
3. 141
4. 143
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Q .3 2Q .3 2 B  is  the father  of C .  Q  is  the s on of P.  M  is  the s on of B.  L  is  the wife of C .  P  is  theB  is  the father  of C .  Q  is  the s on of P.  M  is  the s on of B.  L  is  the wife of C .  P  is  the
wife of M .  How is  Q  related to  C ?wife of M .  How is  Q  related to  C ?

A nsA ns 1. Wife’s brother
2. Wife’s mother
3. Brother’s son 
4. Brother’s wife 

Q .3 3Q .3 3 If  ‘A’ s tands  for  ‘+ ’ ,  ‘B ’ s tands  for  ‘ - ’ ,  ‘C ’ s tands  for  ‘÷ ’ and ‘D ’ s tands  for  ‘× ‘  ,  whatIf  ‘A’ s tands  for  ‘+ ’ ,  ‘B ’ s tands  for  ‘ - ’ ,  ‘C ’ s tands  for  ‘÷ ’ and ‘D ’ s tands  for  ‘× ‘  ,  what
wil l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation?  wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation?  

1 9  D 2  A  8  B  7  C  1  =  ?1 9 D 2  A  8  B  7  C  1  =  ?
A nsA ns 1. 45

2. 31
3. 35
4. 39

Q .3 4Q .3 4 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are theS elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the
numbers  of the fo l lowing s ets .numbers  of the fo l lowing s ets .

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.  Break ing down 1 3as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )a l lowed . )

( 1 6 ,2 ,1 2 6)( 1 6 ,2 ,1 2 6)
( 2 1 ,2 2 ,1 4 6)( 2 1 ,2 2 ,1 4 6)

A nsA ns 1. (21,19,149)
2. (23,4,170)
3. (29,3,69)
4. (53,22,2)
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Q .3 5Q .3 5 E ac h vowel  in the word ‘E A RTH’ is  c hanged to  the letter  immediately  fo l lowing itE ac h vowel  in the word ‘E A RTH’ is  c hanged to  the letter  immediately  fo l lowing it
in the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to  the letterin the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to  the letter
immediately  preceding it  in the E ngl is h a lphabetic al  order.  A l l  the letters  thusimmediately  preceding it  in the E ngl is h a lphabetic al  order.  A l l  the letters  thus
formed are then arranged in the E ngl is h a lphabetic al  order.  Whic h of theformed are then arranged in the E ngl is h a lphabetic al  order.  Whic h of the
fo l lowing letters  wi l l  appear  on the fourth pos it ion from the left  in the newfol lowing letters  wi l l  appear  on the fourth pos it ion from the left  in the new
group of letters  thus  formed?group of letters  thus  formed?

A nsA ns 1. S
2. F
3. Q
4. B

Q .3 6Q .3 6 Pay al  ranked 1 7Pay al  ranked 1 7t ht h  from the top and 24 from the top and 24t ht h  from the bottom in her  c las s .  How many from the bottom in her  c las s .  How many
s tudents  are there in the c las s?s tudents  are there in the c las s?

A nsA ns 1. 39
2. 41
3. 40
4. 42

Q .3 7Q .3 7 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

4 0  4 0  80  80  1 2 0  1 2 0  1 60  1 60  2 0 0  2 0 0  ??
A nsA ns 1. 210

2. 213
3. 240
4. 220
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Q .3 8Q .3 8 S elec t  the tr iad  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two tr iadsS elec t  the tr iad  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two tr iads
given below.  Both tr iads  fo l low the s ame pattern.  given below.  Both tr iads  fo l low the s ame pattern.  

DB  -  G F -  JMDB -  G F -  JM
PN -  S R -  V YPN -  S R -  V Y

A nsA ns 1. EC - HG - KN
2. ST - IG - MP
3. EG - AB - RD
4. OQ - RQ - AC

Q .3 9Q .3 9 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .
C ounting to  be done from left  to  r ight  only .C ounting to  be done from left  to  r ight  only .

( L eft)  ( L eft)  G  G  E  E  H H U U X X  M  M  U U Q  Q  E  E  M  M  S  S  E  E  B  B  T  T  B  B  I  I  H  H J  J  I  I  H  H I  I  ( Right)( Right)

How many  s uc h c ons onants  are there eac h of whic h is  immediately  preceded by  aHow many  s uc h c ons onants  are there eac h of whic h is  immediately  preceded by  a
vowel  and als o  immediately  fo l lowed by  a  vowel?vowel  and als o  immediately  fo l lowed by  a  vowel?

A nsA ns 1. One
2. Three
3. Two
4. Four

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .4 0Q .4 0 Two s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certainTwo s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certain
mathematic al  operat ion(s)  on the firs t  number res ults  in the s ec ond number.mathematic al  operat ion(s)  on the firs t  number res ults  in the s ec ond number.
S imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults  in theS imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults  in the
third  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  ofthird  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  of
operat ions  as  in the given s ets?  operat ions  as  in the given s ets?  

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding /  s ubtrac t ing /mult iply ing to  1 3  c an be performed.  Break ing down 1 3as  adding /  s ubtrac t ing /mult iply ing to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )  a l lowed . )  

1 8  – 2 0  – 1 7  – 1 9 ;  1 8  – 2 0  – 1 7  – 1 9 ;  1 3  – 1 5 – 1 2  – 1 41 3  – 1 5 – 1 2  – 1 4
A nsA ns 1. 28 – 30 – 27 – 29

2. 23 – 20 – 16 – 14
3. 19 – 22 – 20 – 24
4. 15 – 17 – 14 – 12

Q .4 1Q .4 1 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

Bes t  thing s ince s l iced breadBes t  thing s ince s l iced bread
A nsA ns 1. A good idea or plan

2. A mistake that leads to failure
3. A complicated problem with no solution
4. Something that is outdated or old-fashioned

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
___ are going to  the movies  tonight .___ are going to  the movies  tonight .

A nsA ns 1. Us
2. We
3. Yours
4. It

Section : General English and Comprehension
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Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

Dharambir  S ingh ran _____ to  break  his  previous  rec ord .  Dharambir  S ingh ran _____ to  break  his  previous  rec ord .  
A nsA ns 1. fast

2. faster
3. fastly
4. fastest

Q .4 4Q .4 4 S elec t  the mos t appropr iate option that  c an s ubs t itute the under l ined words  inS elec t  the mos t appropr iate option that  c an s ubs t itute the under l ined words  in
the given s entence.the given s entence.

I  am I  am fearful  of  being in c los ed or  c onfined s paces .fearful  of  being in c los ed or  c onfined s paces .
A nsA ns 1. agoraphobic

2. xenophobic
3. claustrophobic
4. acrophobic

Q .4 5Q .4 5 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

L awfulL awful
A nsA ns 1. Approved

2. Illicit
3. Permissible
4. Legal
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.
The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.
People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the
ruins of an ancient city, Hierapolis, also a World Heritage site.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 S elec t  the mos t appropr iate t it le for  the given pas s age.S elec t  the mos t appropr iate t it le for  the given pas s age.
A nsA ns 1. The wonders of Pamukkale

2. A trip to Denizli
3. The magical hot springs
4. Diving into the Roman History
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.
The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.
People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the
ruins of an ancient city, Hierapolis, also a World Heritage site.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 Whic h mineral  is  res pons ible for  the formation of oy s ter- s haped pools  inWhic h mineral  is  res pons ible for  the formation of oy s ter- s haped pools  in

Pamukkale?Pamukkale?
A nsA ns 1. Calcium

2. Potassium
3. Sodium
4. Magnesium
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.
The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.
People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the
ruins of an ancient city, Hierapolis, also a World Heritage site.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 S elec t  the c orrec t  s y nony m of the word ‘c urat ive’ as  us ed in the pas s age.S elec t  the c orrec t  s y nony m of the word ‘c urat ive’ as  us ed in the pas s age.

A nsA ns 1. Transparent
2. Therapeutic
3. Malleable
4. Noxious
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.
The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.
People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the
ruins of an ancient city, Hierapolis, also a World Heritage site.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 S elec t  the mos t appropr iate A NTO NYM  of the word ‘s pec tac ular ’ as  us ed in theS elec t  the mos t appropr iate A NTO NYM  of the word ‘s pec tac ular ’ as  us ed in the

pas s age.pas s age.
A nsA ns 1. Weary

2. Impressive
3. Combustible
4. Stupendous
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.
The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.
People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the
ruins of an ancient city, Hierapolis, also a World Heritage site.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 Identify  the tone of the pas s age.Identify  the tone of the pas s age.
A nsA ns 1. Informative

2. Tragic
3. Indignant
4. Nostalgic

Section : General Hindi and Comprehension
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Q . 51Q . 51 '' अ[अ[ ' '  काका   ^वलो म^वलो म   शdशd   हैहै --
A nsA ns 1. अवसान

2. अiुदय
3. आnद
4. उदय

Q . 52Q . 52 िq यािq या   ^वशेष ण^वशेष ण   शdशd   कोको   यथा vा नयथा vा न   भरyभरy --
क लक ल   मेरेमेरे   िप ता जीिप ता जी  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . आआ   ग एग ए ।।

A nsA ns 1. तड़ातड़
2. अक�ात
3. ज�ी मy
4. nदन तक

Q . 53Q . 53 ‘‘ ती नती न   मyमy   नन   त ेर हतेर ह   मyमy ’ ’ लो को ��लो को ��   काका   �ा�ा   अथ�अथ�   हैहै ??
A nsA ns 1. एक से बढ़कर दूसरा चालाक

2. �गनती करना
3. अ��धक द�र�
4. कुछ भी मह� नह� है

Q . 54Q . 54 ^न��ल�ख त^न��ल�ख त   ^वक ��^वक ��   मyमy   सेसे   चा वलचा वल   काका   प य� यवा चीप य� यवा ची   शdशd   प हचा नyप हचा नy ।।
A nsA ns 1. केतन

2. तंदुल
3. �मोष
4. अंभ

Q . 55Q . 55 मुहा वरेमुहा वरे   केके   सहीसही   अथ�अथ�   काका   चयनचयन   क रyक रy --
‘‘ उ धा रउ धा र   खा येखा ये   बैठनाबैठना ’’

A nsA ns 1. अनुभव �ा� करना
2. कोई कसर न रखना
3. तैयार रहना
4. �ती ा मy रहना
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C omprehens ion:C omprehens ion:
nदए गए ग¡¢◌ंश के आधार पर ^न�¢िकत �¤� के उ¥र दी�जए--

इस समय जनस¥ा संसार के ��ेक देश के दरवाजे पर द[क दे रही है और आज वह अपने मजबूत हाथ� मy
भारतवष� के दरवाजे क¨ जंजीर भी खटखटाती हुई उस अ�ंत �ाचीन भू^म के ^नवा�सय� से �¤ करती है िक
बतलाओ, तुम नवयुग का «ागत िकस �कार करना चाहते हो? संसार मy भाव� का एक तूफान चल रहा है। पुराने
भावी के पैर nहल गये ह­। संसार के ��ेक देश मy ऐसा हुआ है, इस देश मy भी ऐसा ही हो रहा है। नये भाव� का «ागत
न करना आसान है, परंतु बुरा है। �जन भाव� क¨ जड़ nहल गयी है, यnद उनका vान ¯हण करने के और उपयोगी भाव�
को अवसर न nदया गया तो, °दय-°दय नह� रह जायेगा। वह अ±ान क¨ गत� मy �गर जायेगा , या �स²¢तहीन शु³
तक�  के मायाजाल मy जो लोग पुराने खंडहर� क¨ र ा के �लए इस आदश�हीनता का युग अपने देश मy अवत�रत करना
चाहते ह­, वे याद रखy िक उनके इस काम से देश के सामने महान आदश� लोप हो जायyगे। ^नःसंदेह खंडहर बच जायyगे,
परंतु इस�लए नह� िक वे उ¶ुक आ·ाओं को ऊँचे आदशº का संदेश सुनावy, िकंतु इस�लए िक पुरात�वे¥ा उ»y
देखकर उनके �ाचीन मह� क¨ दाद दy।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 ^न��ल�ख त^न��ल�ख त   ^वक ��^वक ��   मyमy   सेसे   कौ नसाकौ नसा   ^वक �^वक �   �स²¢ त�स²¢ त   शdशd   काका   प य� यवा चीप य� यवा ची   शdशd   नह�नह�   हैहै ??
A nsA ns 1. मत

2. ^नयम
3. धारणा
4. �स½²
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C omprehens ion:C omprehens ion:
nदए गए ग¡¢◌ंश के आधार पर ^न�¢िकत �¤� के उ¥र दी�जए--

इस समय जनस¥ा संसार के ��ेक देश के दरवाजे पर द[क दे रही है और आज वह अपने मजबूत हाथ� मy
भारतवष� के दरवाजे क¨ जंजीर भी खटखटाती हुई उस अ�ंत �ाचीन भू^म के ^नवा�सय� से �¤ करती है िक
बतलाओ, तुम नवयुग का «ागत िकस �कार करना चाहते हो? संसार मy भाव� का एक तूफान चल रहा है। पुराने
भावी के पैर nहल गये ह­। संसार के ��ेक देश मy ऐसा हुआ है, इस देश मy भी ऐसा ही हो रहा है। नये भाव� का «ागत
न करना आसान है, परंतु बुरा है। �जन भाव� क¨ जड़ nहल गयी है, यnद उनका vान ¯हण करने के और उपयोगी भाव�
को अवसर न nदया गया तो, °दय-°दय नह� रह जायेगा। वह अ±ान क¨ गत� मy �गर जायेगा , या �स²¢तहीन शु³
तक�  के मायाजाल मy जो लोग पुराने खंडहर� क¨ र ा के �लए इस आदश�हीनता का युग अपने देश मy अवत�रत करना
चाहते ह­, वे याद रखy िक उनके इस काम से देश के सामने महान आदश� लोप हो जायyगे। ^नःसंदेह खंडहर बच जायyगे,
परंतु इस�लए नह� िक वे उ¶ुक आ·ाओं को ऊँचे आदशº का संदेश सुनावy, िकंतु इस�लए िक पुरात�वे¥ा उ»y
देखकर उनके �ाचीन मह� क¨ दाद दy।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 ग ¡¢ शग ¡¢ श   केके   आ धा रआ धा र   प रप र   उ ¥ रउ ¥ र   दyदy ।।

कौ नकौ न   खंड हर�खंड हर�   कोको   दे ख क रदे ख क र   उ नकेउ नके   �ा ची न�ा ची न   मह�मह�   क¨क¨   दा ददा द   दy ग ेदy ग े ।।
A nsA ns 1. खगोल �श क

2. पुरात�वे¥ा
3. इ^तहासकार
4. संगीतकार
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C omprehens ion:C omprehens ion:
nदए गए ग¡¢◌ंश के आधार पर ^न�¢िकत �¤� के उ¥र दी�जए--

इस समय जनस¥ा संसार के ��ेक देश के दरवाजे पर द[क दे रही है और आज वह अपने मजबूत हाथ� मy
भारतवष� के दरवाजे क¨ जंजीर भी खटखटाती हुई उस अ�ंत �ाचीन भू^म के ^नवा�सय� से �¤ करती है िक
बतलाओ, तुम नवयुग का «ागत िकस �कार करना चाहते हो? संसार मy भाव� का एक तूफान चल रहा है। पुराने
भावी के पैर nहल गये ह­। संसार के ��ेक देश मy ऐसा हुआ है, इस देश मy भी ऐसा ही हो रहा है। नये भाव� का «ागत
न करना आसान है, परंतु बुरा है। �जन भाव� क¨ जड़ nहल गयी है, यnद उनका vान ¯हण करने के और उपयोगी भाव�
को अवसर न nदया गया तो, °दय-°दय नह� रह जायेगा। वह अ±ान क¨ गत� मy �गर जायेगा , या �स²¢तहीन शु³
तक�  के मायाजाल मy जो लोग पुराने खंडहर� क¨ र ा के �लए इस आदश�हीनता का युग अपने देश मy अवत�रत करना
चाहते ह­, वे याद रखy िक उनके इस काम से देश के सामने महान आदश� लोप हो जायyगे। ^नःसंदेह खंडहर बच जायyगे,
परंतु इस�लए नह� िक वे उ¶ुक आ·ाओं को ऊँचे आदशº का संदेश सुनावy, िकंतु इस�लए िक पुरात�वे¥ा उ»y
देखकर उनके �ाचीन मह� क¨ दाद दy।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 उ प रो �उ प रो �   ग ¡¢ शग ¡¢ श   केके   आ धा रआ धा र   प रप र   ^न��ल�ख त^न��ल�ख त   मyमy   सेसे   कौ नसाकौ नसा   वा �वा �   अस�अस�   हैहै ??
A nsA ns 1. नए भाव� को «ीकारने से ही °दय °दय बन पाएगा।

2. नये भाव� का «ागत न करना अ�ंत कnठन कृ� है।
3. �स²¢तहीन शु³ तक�  से महान आदश� का लोप हो जायेगा।
4. संसार मy नए भाव� का आगमन हुआ है।
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C omprehens ion:C omprehens ion:
nदए गए ग¡¢◌ंश के आधार पर ^न�¢िकत �¤� के उ¥र दी�जए--

इस समय जनस¥ा संसार के ��ेक देश के दरवाजे पर द[क दे रही है और आज वह अपने मजबूत हाथ� मy
भारतवष� के दरवाजे क¨ जंजीर भी खटखटाती हुई उस अ�ंत �ाचीन भू^म के ^नवा�सय� से �¤ करती है िक
बतलाओ, तुम नवयुग का «ागत िकस �कार करना चाहते हो? संसार मy भाव� का एक तूफान चल रहा है। पुराने
भावी के पैर nहल गये ह­। संसार के ��ेक देश मy ऐसा हुआ है, इस देश मy भी ऐसा ही हो रहा है। नये भाव� का «ागत
न करना आसान है, परंतु बुरा है। �जन भाव� क¨ जड़ nहल गयी है, यnद उनका vान ¯हण करने के और उपयोगी भाव�
को अवसर न nदया गया तो, °दय-°दय नह� रह जायेगा। वह अ±ान क¨ गत� मy �गर जायेगा , या �स²¢तहीन शु³
तक�  के मायाजाल मy जो लोग पुराने खंडहर� क¨ र ा के �लए इस आदश�हीनता का युग अपने देश मy अवत�रत करना
चाहते ह­, वे याद रखy िक उनके इस काम से देश के सामने महान आदश� लोप हो जायyगे। ^नःसंदेह खंडहर बच जायyगे,
परंतु इस�लए नह� िक वे उ¶ुक आ·ाओं को ऊँचे आदशº का संदेश सुनावy, िकंतु इस�लए िक पुरात�वे¥ा उ»y
देखकर उनके �ाचीन मह� क¨ दाद दy।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 उ प रो �उ प रो �   ग ¡¢ शग ¡¢ श   हेत ुहेत ु   उ ¿चतउ ¿चत   शी ष �कशी ष�क   काका   चयनचयन   क रyक रy ।।
A nsA ns 1. स¢स�रक जीवन

2. नयी �कृ^त
3. नवयुग और नए भाव
4. देश और माटी
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C omprehens ion:C omprehens ion:
nदए गए ग¡¢◌ंश के आधार पर ^न�¢िकत �¤� के उ¥र दी�जए--

इस समय जनस¥ा संसार के ��ेक देश के दरवाजे पर द[क दे रही है और आज वह अपने मजबूत हाथ� मy
भारतवष� के दरवाजे क¨ जंजीर भी खटखटाती हुई उस अ�ंत �ाचीन भू^म के ^नवा�सय� से �¤ करती है िक
बतलाओ, तुम नवयुग का «ागत िकस �कार करना चाहते हो? संसार मy भाव� का एक तूफान चल रहा है। पुराने
भावी के पैर nहल गये ह­। संसार के ��ेक देश मy ऐसा हुआ है, इस देश मy भी ऐसा ही हो रहा है। नये भाव� का «ागत
न करना आसान है, परंतु बुरा है। �जन भाव� क¨ जड़ nहल गयी है, यnद उनका vान ¯हण करने के और उपयोगी भाव�
को अवसर न nदया गया तो, °दय-°दय नह� रह जायेगा। वह अ±ान क¨ गत� मy �गर जायेगा , या �स²¢तहीन शु³
तक�  के मायाजाल मy जो लोग पुराने खंडहर� क¨ र ा के �लए इस आदश�हीनता का युग अपने देश मy अवत�रत करना
चाहते ह­, वे याद रखy िक उनके इस काम से देश के सामने महान आदश� लोप हो जायyगे। ^नःसंदेह खंडहर बच जायyगे,
परंतु इस�लए नह� िक वे उ¶ुक आ·ाओं को ऊँचे आदशº का संदेश सुनावy, िकंतु इस�लए िक पुरात�वे¥ा उ»y
देखकर उनके �ाचीन मह� क¨ दाद दy।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 ^न��ल�ख त^न��ल�ख त   ^वक ��^वक ��   मyमy   सेसे   कौ नसाकौ नसा   ^वक �^वक �   �ा ची न�ा ची न   शdशd   काका   ^वलो म^वलो म   शdशd   हैहै ??

A nsA ns 1. स¢सा�रक
2. ^नव�¿चन

3. आÀाÁ·क
4. अव�चीन

Q .61Q .61 Whic h of the fo l lowing c omponents  are part  of  the C entral  Proces s ing UnitWhic h of the fo l lowing c omponents  are part  of  the C entral  Proces s ing Unit
(C PU) ?(C PU) ?

A nsA ns 1. Memory Unit and Input/Output Unit
2. Arithmetic Logic Unit (ALU) and Control Unit (CU)
3. Control Unit (CU) and Storage Unit
4. Arithmetic Logic Unit (ALU) and Memory Unit

Q .62Q .62
A nsA ns 1. 

2. 
3. 
4. 

Section : Basic Knowledge of Computer
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Q .63Q .63 In M S  Word ,  whic h of the fo l lowing text  a l ignments  is  the hardes t  to  read ,In M S  Word ,  whic h of the fo l lowing text  a l ignments  is  the hardes t  to  read ,
es pec ia l ly  in large bloc ks?es pec ial ly  in large bloc ks?

A nsA ns 1. Justified
2. Left-aligned
3. Right-aligned
4. Center-aligned

Q .64Q .64 In M S  Word ,  whic h of the fo l lowing ac t ions  wi l l  c orrec t ly  s ave a  c opy  of anIn M S  Word ,  whic h of the fo l lowing ac t ions  wi l l  c orrec t ly  s ave a  c opy  of an
exis t ing doc ument with a  new name and in a  d ifferent file format ,  whi leexis t ing doc ument with a  new name and in a  d ifferent file format ,  whi le
pres erv ing the or iginal  doc ument?pres erv ing the or iginal  doc ument?

A nsA ns 1. Go to the Insert tab, click Save, enter a new name, choose a different file format, and
click Save.

2. Go to the File tab, select Save, enter a new name, and choose a different file format.
3. Go to the Home tab, click Save As, enter a new name, and click Save.
4. Go to the File tab, select Save As, enter a new name, choose a different file format,

and click Save.

Q .65Q .65 Whic h of the fo l lowing options  in the Fi le menu al lows  us ers  to  s ave a  newWhic h of the fo l lowing options  in the Fi le menu al lows  us ers  to  s ave a  new
workbook  for  the firs t  t ime in M S  E xcel?workbook  for  the firs t  t ime in M S  E xcel?

A nsA ns 1. Print
2. Save
3. Open
4. Save As
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Q .66Q .66 In c onfiguring a web brows er,  whic h of the fo l lowing s teps  are required to  enableIn c onfiguring a web brows er,  whic h of the fo l lowing s teps  are required to  enable
JavaS c r ipt  in G oogle C hrome,  ens ur ing that  webs ites  rely ing on JavaS c r iptJavaS c r ipt  in G oogle C hrome,  ens ur ing that  webs ites  rely ing on JavaS c r ipt
func t ion c orrec t ly ?func t ion c orrec t ly ?

A nsA ns 1. Go to the Settings menu, select Privacy and Security, click on Site Settings, navigate
to JavaScript, and toggle the switch to Allowed.

2. Go to the Settings menu, select Advanced, click on Network, navigate to JavaScript,
and toggle the switch to Allowed.

3. Go to the Tools menu, select Options, click on Advanced, navigate to JavaScript, and
toggle the switch to Allowed.

4. Go to the File menu, select Preferences, click on Security, navigate to JavaScript, and
toggle the switch to Allowed.

Q .67Q .67 Whic h tab on the M S  PowerPoint  Ribbon al lows  us ers  to  c hange the template orWhic h tab on the M S  PowerPoint  Ribbon al lows  us ers  to  c hange the template or
theme of the pres entat ion?theme of the pres entat ion?

A nsA ns 1. Design
2. Transitions
3. Animations
4. Home

Q .68Q .68 Whic h of the fo l lowing tabs  a l lows  y ou to  c hange the formatt ing of s elec ted textWhic h of the fo l lowing tabs  a l lows  y ou to  c hange the formatt ing of s elec ted text
in M ic ros oft  Word?in M ic ros oft  Word?

A nsA ns 1. Review
2. Insert
3. File
4. Home

Q .69Q .69
A nsA ns 1. 

2. 
3. 
4. 
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Q .70Q .70 Whic h of the fo l lowing is  the default  loc at ion where deleted files  are temporar i lyWhic h of the fo l lowing is  the default  loc at ion where deleted files  are temporar i ly
s tored in M S  Windows  O S  before they  are permanently  removed?s tored in M S  Windows  O S  before they  are permanently  removed?

A nsA ns 1. Waste Basket
2. Deleted Items
3. Trash
4. Recycle Bin

Q .71Q .71 In the c ontext  of  c omputers ,  what are worms  and v irus es?In the c ontext  of  c omputers ,  what are worms  and v irus es?
A nsA ns 1. Software programs that cause problems on a computer

2. Hardware components of a computer
3. Security features installed on a computer
4. Programs that enhance computer performance

Q .72Q .72 The s hortc uts  to  ins ert  and delete s l ides  in an M S  PowerPoint  pres entat ion are:The s hortc uts  to  ins ert  and delete s l ides  in an M S  PowerPoint  pres entat ion are:
A nsA ns 1. Inserting – Alt + M; Deleting – Hold Ctrl, Select and Press Delete

2. Inserting – Shift + M; Deleting – Hold Ctrl, Select and Press Delete
3. Inserting – Ctrl + N; Deleting – Hold Ctrl, Select and Press Delete
4. Inserting – Ctrl + M; Deleting – Hold Ctrl, Select and Press Delete

Q .73Q .73 When c onfiguring an email  c l ient ,  what information is  required to  s et  up anWhen c onfiguring an email  c l ient ,  what information is  required to  s et  up an
inc oming mai l  s erver?inc oming mai l  s erver?

A nsA ns 1. Username and password
2. Encryption key
3. Server hostname and port number
4. Sender's email address

Q .74Q .74 How do y ou c reate a  c us tom dic t ionary  in M S  Word to  s tore a  l is t  of  frequentlyHow do y ou c reate a  c us tom dic t ionary  in M S  Word to  s tore a  l is t  of  frequently
mis s pel led  words?mis s pel led  words?

A nsA ns 1. Go to Insert > Reference > Custom Dictionaries 
2. Go to Review > Spelling & Grammar > Custom Dictionaries 
3. There is no way to create a custom dictionary in MS Word.
4. Go to Tools > Options > Spelling and Grammar
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Q .75Q .75
A nsA ns 1. 

2. 
3. 
4. 

Q .76Q .76 What happens  if  y ou try  to  c los e an uns aved workbook  in M S  E xcel  2 0 1 9?What happens  if  y ou try  to  c los e an uns aved workbook  in M S  E xcel  2 0 1 9?
A nsA ns 1. The computer restarts automatically.

2. A warning message appears asking if you want to save your changes.
3. The workbook is deleted.
4. The workbook closes immediately.

Q .77Q .77 When opening an email  in a  web- bas ed email  c l ient ,  whic h of the fo l lowingWhen opening an email  in a  web- bas ed email  c l ient ,  whic h of the fo l lowing
ac t ions  is  general ly  NO T required to  v iew the email  c ontents?ac t ions  is  general ly  NO T required to  v iew the email  c ontents?

A nsA ns 1. Logging into your email account
2. Clicking on the email subject line
3. Selecting the email from your inbox
4. Downloading an attachment before reading the email

Q .78Q .78 Whic h feature of G oogle Doc s  a l lows  mult iple us ers  to  c o l laborate on a doc umentWhic h feature of G oogle Doc s  a l lows  mult iple us ers  to  c o l laborate on a doc ument
in real- t ime?in real- t ime?

A nsA ns 1. Print preview
2. Real-time collaboration
3. Offline mode

4. Version history

Q .79Q .79 Whic h of the fo l lowing is  NO T a us e of an ant iv irus?Whic h of the fo l lowing is  NO T a us e of an ant iv irus?
A nsA ns 1. Secure monitor

2. Protection of computer from virus
3. Scan files
4. Delete malicious files

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .80Q .80 Whic h tool  in Windows  helps  ins tal l  and manage hardware dr ivers?Whic h tool  in Windows  helps  ins tal l  and manage hardware dr ivers?
A nsA ns 1. Device Manager

2. Task Manager
3. BIOS
4. Control Panel

Q .81Q .81
A nsA ns 1. 

2. 
3. 
4. 

Q .82Q .82 O ne y ear  ago ,  the rat io  between S amir 's  and A s hok 's  ages  was  3  :  4 .  A fter  twoO ne y ear  ago ,  the rat io  between S amir 's  and A s hok 's  ages  was  3  :  4 .  A fter  two
y ears ,  the rat io  of  their  ages  wi l l  be 4  :  5 .  What is  the s um of their  pres ent ages?y ears ,  the rat io  of  their  ages  wi l l  be 4  :  5 .  What is  the s um of their  pres ent ages?

A nsA ns 1. 21 years
2. 25 years
3. 23 years
4. 19 years

Q .83Q .83 A  dealer  buy s  two art ic les  X  and Y  for  ₹4 ,0 0 0  eac h.  He marks  eac h of them at  theA  dealer  buy s  two art ic les  X  and Y  for  ₹4 ,0 0 0  eac h.  He marks  eac h of them at  the
s ame pr ice.  He s el ls  X  by  giv ing two s ucces s ive d is c ounts  of 78% and 64% ands ame pr ice.  He s el ls  X  by  giv ing two s ucces s ive d is c ounts  of 78% and 64% and
s t i l l  earns  ₹1 58 as  profit .  I f  he s el ls  Y  at  a  s ingle d is c ount of 88%, then what iss t i l l  earns  ₹1 58 as  profit .  I f  he s el ls  Y  at  a  s ingle d is c ount of 88%, then what is
the profit percentage on Y?the profit percentage on Y?

A nsA ns 1. 
2. 
3. 
4. 

Q .84Q .84 The populat ion in a  v i l lage is  inc reas ed by  0 .8% in 2 0 2 2  and again by  0 .75% inThe populat ion in a  v i l lage is  inc reas ed by  0 .8% in 2 0 2 2  and again by  0 .75% in
2 0 2 3.  Find the final  percentage inc reas e in the populat ion of the v i l lage.2 0 2 3.  Find the final  percentage inc reas e in the populat ion of the v i l lage.

A nsA ns 1. 1.545%
2. 1.565%
3. 1.556%
4. 1.566%

Section : Quantitative Aptitude
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Q .85Q .85 E valuate the fo l lowing:E valuate the fo l lowing:

3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 1  + 8) } ]3 5 − [ 2 5 − { 3 1  − ( 2 2  − 1 1  + 8) } ]
A nsA ns 1. 22

2. 25
3. 19
4. 21

Q .86Q .86 Find the value of m,  s at is fy ing equation:Find the value of m,  s at is fy ing equation:

A nsA ns 1. 

2. 

3. 

4. 

Q .87Q .87 Pipes  A ,  B  and C  c an fil l  a  tank  in 1 5,  3 0  and 4 0  hours ,  res pec t ively .  P ipes  A ,  B  andPipes  A ,  B  and C  c an fil l  a  tank  in 1 5,  3 0  and 4 0  hours ,  res pec t ively .  P ipes  A ,  B  and
C  are opened at  7  a .m. ,  9  a .m.  and 1 1  a .m. ,  res pec t ively ,  on the s ame day .  A t  whatC  are opened at  7  a .m. ,  9  a .m.  and 1 1  a .m. ,  res pec t ively ,  on the s ame day .  A t  what
t ime wi l l  the tank  be ful l?t ime wi l l  the tank  be ful l?

A nsA ns 1. 3:40 p.m.
2. 3:20 p.m.

3. 4:20 p.m.
4. 4:45 p.m.

Q .88Q .88
A nsA ns 1. 

2. 

3. 

4. 
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Q .89Q .89 In the elec t ion for  c hairman between two c andidates  M  and K,  56% of a l l  va l idIn the elec t ion for  c hairman between two c andidates  M  and K,  56% of a l l  va l id
voters  s upported the winner  c andidate M ,  who received 9 ,43 5 more votes  than K .voters  s upported the winner  c andidate M ,  who received 9 ,43 5 more votes  than K .
A cc ording to  the rec ords ,  1 5% of the votes  were dec lared inval id ,  and al l  theA cc ording to  the rec ords ,  1 5% of the votes  were dec lared inval id ,  and al l  the
voters  c as t  their  votes .  The total  number of voters  in the l is t  was :voters  c as t  their  votes .  The total  number of voters  in the l is t  was :

A nsA ns 1. 85,000
2. 85,200
3. 95,000
4. 92,500

Q .90Q .90 How muc h percentage dec reas e from 80 0  wi l l  give 73 6?How muc h percentage dec reas e from 80 0  wi l l  give 73 6?
A nsA ns 1. 6%

2. 11%
3. 8%
4. 12%

Q .91Q .91 4  t imes  the pres ent age of L at ika is  1 8  y ears  more than 3  t imes  the pres ent age4  t imes  the pres ent age of L at ika is  1 8  y ears  more than 3  t imes  the pres ent age
of S has hank ,  and 4  t imes  the pres ent age of S has hank  is  1 2  y ears  les s  than 4of S has hank ,  and 4  t imes  the pres ent age of S has hank  is  1 2  y ears  les s  than 4
t imes  the pres ent age of L at ika .  The s um of the pres ent ages  ( in y ears)  of  L at ikat imes  the pres ent age of L at ika .  The s um of the pres ent ages  ( in y ears)  of  L at ika
and S has hank  is :and S has hank  is :

A nsA ns 1. 15
2. 12
3. 11
4. 13

Q .92Q .92 The average of the marks  of 1 5 s tudents  in a  c las s  is  4 8 .  I f  the marks  of eac hThe average of the marks  of 1 5 s tudents  in a  c las s  is  4 8 .  I f  the marks  of eac h
s tudent are doubled ,  find the new average.s tudent are doubled ,  find the new average.

A nsA ns 1. 96
2. 15
3. 30
4. 48
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Q .93Q .93 A  retai ler  buy s  an elec tronic  item for  ₹1 75.  H is  overhead expens es  are ₹2 5.  HeA  retai ler  buy s  an elec tronic  item for  ₹1 75.  H is  overhead expens es  are ₹2 5.  He
s el ls  the elec tronic  item for  ₹4 60  and makes  x% profit .  The value of x  is :s el ls  the elec tronic  item for  ₹4 60  and makes  x% profit .  The value of x  is :

A nsA ns 1. 150
2. 120
3. 110
4. 130

Q .94Q .94 A n item is  marked 72 % higher  than its  c os t  pr ice.  E ven after  a l lowing s omeA n item is  marked 72 % higher  than its  c os t  pr ice.  E ven after  a l lowing s ome
dis c ount ,  the s hopkeeper  earned 2 9% profit .  F ind the d is c ount percentagedis c ount ,  the s hopkeeper  earned 2 9% profit .  F ind the d is c ount percentage
al lowed by  the s hopkeeper.a l lowed by  the s hopkeeper.

A nsA ns 1. 26%
2. 23%
3. 28%
4. 25%

Q .95Q .95 The s um of five numbers  is  655.  The average of the firs t  two numbers  is  75 andThe s um of five numbers  is  655.  The average of the firs t  two numbers  is  75 and
the third  number is  1 0 1 .  F ind the average of the remaining two numbers?the third  number is  1 0 1 .  F ind the average of the remaining two numbers?

A nsA ns 1. 202
2. 177
3. 203
4. 176

Q .96Q .96 Ravneet and her  family  go boating in a  r iver.  The boatman s ay s  that  the s peed ofRavneet and her  family  go boating in a  r iver.  The boatman s ay s  that  the s peed of
his  boat ing in s t i l l  water  is  1 3  km/ hr  but the water  s tream is  fl owing at  a  s peedhis  boat ing in s t i l l  water  is  1 3  km/ hr  but the water  s tream is  fl owing at  a  s peed
of 4  km/ hr.  They  c overed a d is tance of 3 6  km in d irec t ion of the fl ow of waterof 4  km/ hr.  They  c overed a d is tance of 3 6  km in d irec t ion of the fl ow of water
and returned to  the s tart ing point .  For  how muc h t ime do they  enjoy  boating?and returned to  the s tart ing point .  For  how muc h t ime do they  enjoy  boating?
( Rounded to  the neares t  of  minutes)( Rounded to  the neares t  of  minutes)

A nsA ns 1. 5 hours 45 minutes
2. 6 hours 20 minutes
3. 6 hours 05 minutes
4. 6 hours 07 minutes
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Q .97Q .97 If  a  man bought 7  s harpeners  for  ₹4 ,  and s o ld  them at  5 s harpeners  for  ₹9 ,  thenIf  a  man bought 7  s harpeners  for  ₹4 ,  and s o ld  them at  5 s harpeners  for  ₹9 ,  then
the gain percentage is  _______%.the gain percentage is  _______%.

A nsA ns 1. 215
2. 225
3. 235
4. 205

Q .98Q .98 Nis ha earned ₹P and s pent 4 0 % on food and trans port ,  2 5% of the remainingNis ha earned ₹P and s pent 4 0 % on food and trans port ,  2 5% of the remaining
amount on books  and s aved ₹1 1 ,970 ,  then the value of P  is :amount on books  and s aved ₹1 1 ,970 ,  then the value of P  is :

A nsA ns 1. 26,600
2. 25,000
3. 22,950
4. 20,500

Q .99Q .99 A nkit  runs  from his  hous e to  the park  3  km away  in 3 0  minutes  and returns  homeA nkit  runs  from his  hous e to  the park  3  km away  in 3 0  minutes  and returns  home
in 1 5 minutes .  F ind his  average s peed .in 1 5 minutes .  F ind his  average s peed .

A nsA ns 1. 10 km/hr
2. 8 km/hr
3. 12 km/hr
4. 6 km/hr

Q .1 0 0Q .1 0 0 A  c is tern is  normally  fil led  in 1 2  hours  but takes  4  hours  longer  to  fil l  bec aus e ofA  c is tern is  normally  fil led  in 1 2  hours  but takes  4  hours  longer  to  fil l  bec aus e of
a leak  at  the bottom.  I f  the c is tern is  ful l ,  the leak  wi l l  empty  half  of  it  in _______ .a  leak  at  the bottom.  I f  the c is tern is  ful l ,  the leak  wi l l  empty  half  of  it  in _______ .

A nsA ns 1. 24 hours
2. 36 hours
3. 48 hours
4. 12 hours
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